Chapter 3

Adding Relations and
Dimensions to the
Sketches

Learning Objectives

After completing this chapter you will be able to:
* Add geometric relations to the sketch.

* Dimension the sketches.

* Modify the dimensions of the sketch.

* Understand the concept of fully defined sketch.

* View and examine the relations applied to the sketches.
* Open an existing file.
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ADDING GEOMETRIC RELATIONS TO THE SKETCH

As discussed earlier, the geometric relations are the logical operations that are performed to add
a relationship (such as tangent or perpendicular) between the sketched entities, planes, axes,
edges, or vertices. The relations applied to the sketched entities are used to capture the design
intent. The geometric relations constrain the degree of freedom of the sketched entities. There
are two methods to apply the relations to the sketch. These two methods are

1. Add Relations PropertyManager
2. Automatic Relations

Adding Relations Using the Add Relations PropertyManager

Toolbar: Sketch Relations > Add Relation
Menu: Tools > Relations > Add

The Add Relations PropertyManager is widely used to apply relation to the sketch in
H the sketcher environment of SolidWorks. The Add Relations PropertyManager is invoked

using the Add Relation button from the Sketch Relations toolbar. The Add Relations
PropertyManager is displayed on the left of the drawing area as soon as you choose the Add
Relation button. You can also invoke the Add Relations PropertyManager by right-clicking in
the drawing area and choosing the Add Relation option from the shortcut menu. The Add
Relations PropertyManager is invoked as shown in Figure 3-1. The confirmation corner is also
displayed at the top right corner of the drawing area. The various options available in the Add
Relations PropertyManager are discussed next.
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Figure 3-1 The Add Relations PropertyManager
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Selected Entities

The Selected Entities rollout displays the name of the entities that are selected to apply the
relations. The entities are added in the area under the Selected Entities rollout by selecting
them from the graphics area. The selected entities are displayed in green color. You can remove
the selected entity from the selection set by selecting the same entity from the drawing area using
the left mouse button. You will notice that the color of the entity is changed from green to blue.

Tip. You can also remove the selected entity from the selection set by choosing that
; entity in the Selected Entities rollout and use the right mouse button to invoke the
Q\/ shortcut menu. Choose the Delete option from this menw to remove the entity from
the selection set. If you choose the Clear Selections option from the shortcut menw

then all the entities will be removed from the selection set.

Existing Relations

The Existing Relations rollout displays the relations that are already applied to the selected
sketch entities. It also shows the status of the sketch entities. You can delete the already existing
relation from the Existing Relations rollout. Select the already existing relation from the selection
area and right-click to display the shortcut menu. Choose the Delete option from this shortcut
menu to delete the selected relation. If you choose the Delete All option from the shortcut
menu, all the relations displayed in the selection area of the Existing Relations rollout will be
deleted. The status of the sketch entity is displayed below the selection area. You will learn more
about the status of the selected sketch entity and the status of the entire sketch later in this
chapter.

Add Relations

The Add Relations rollout is used to apply the relations to the selected entity. The list of
relations that can be applied to the selected entity or entities is shown in the Add Relations
rollout. Note that only the relations that can be applied to the selected entity or entities are
displayed in the list. The most appropriate relation for the selected entities appears in bold
letters.

Tip. You can apply a relation to a single entity or a relation between two or more
than two entities. For applying a relation between two or more than two entities at
least one entity should be a sketched entity. The other entity or entities can be sketch
entities, edges, faces, vertices, origins, plane, or axes. The sketch curves from other
sketches that form lines or arcs when projected on the sketch plane can also be
included in the relation.

You will learn more about projected sketch curves and planes in the later chapters.
The relations that can be applied to the sketches using the Add Relations rollout are discussed next.

Horizontal
IEI Horizontal The Horizontal relation forces the selected line or lines to become horizontal.
Aline can be a line, or center line in the sketch, or an external entity such as
an edge, plane, axis, or sketch curve on an external sketch that projects as a
line in the sketch. Using the Horizontal relation you can also force two or more points to
become horizontal. A point can be a sketch, a centerpoint, an endpoint, a control point of
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a spline, or an external entity such as origin, vertex, axis, or point in an external sketch that
projects as a point. To use this relation, choose the Add Relation button from the Sketch
Relations toolbar to display the Add Relations PropertyManager. Select the entity or
entities to apply the Horizontal relation. Choose the Horizontal button from the Add
Relations rollout provided in the Add Relations PropertyManager. You will notice that
the name of the horizontal relation is displayed in the Existing Relations rollout.

Vertical
III Vertical | e Vertical relation forces the selected line or lines to become vertical. Using
the Vertical relation you can also force two or more points to become vertical. To
use this relation, choose the Add Relation button from the Sketch Relations
toolbar to display the Add Relations PropertyManager. Select the entity or entities to
apply the Vertical relation. Choose the Vertical button from the Add Relations rollout
provided in the Add Relations PropertyManager. You will notice that the name of the
vertical relation is displayed in the Existing Relations rollout.

Collinear
Collinear The Collinear relation forces the selected lines to lie on the same infinite line.
To use this relation invoke the Add Relations PropertyManager. Select the
line to apply the Collinear relation. Choose the Collinear button from the
Add Relations rollout.

Coradial
Coradial The Coradial relation forces the selected arcs to share the same radius and the
- same centerpoint. An arc can be an arc or a circle in a sketch, or an external
entity that projects as an arc or a circle in the sketch. To use this relation,
invoke the Add Relations PropertyManager. Select two arcs or circles, or an arc and a
circle to apply the Coradial relation. Choose the Coradial button from the Add Relations rollout.

Perpendicular
Perpendicular The Perpendicular relation forces the selected lines to become
perpendicular to each other. To use this relation, invoke the Add Relations
PropertyManager. Select two lines to apply the Perpendicular relation.
Choose the Perpendicular button from the Add Relations rollout. Figure 3-2 shows two
lines before and after applying the perpendicular relation.

Parallel
Parallel  1he Parallel relation forces the selected lines to become parallel to each other.
To use this relation, invoke the Add Relations PropertyManager. Select two
lines to apply the Parallel relation. Choose the Parallel button from the Add
Relations rollout to apply the parallel relation. Figure 3-3 shows two lines before and after

applying this relation.
ParallelYZ
ParallehZ The Parallel YZ relation forces a line in the 3D sketch to become parallel to

the YZ plane with respect to the selected plane. To use this relation, invoke
the Add Relations PropertyManager. Select the line in the 3D sketch and
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a plane and choose the ParallelYZ button from the Add Relations rollout.

ParallelZzX
ParalleF The ParallelZX relation forces a line in the 3D sketch to become parallel to
the ZX plane with respect to the selected plane. To use this relation, invoke
the Add Relations PropertyManager. Select the line in the 3D sketch and
a plane and choose the ParallelZX button from the Add Relations rollout.

AlongZ
Ia Along? The AlongZ relation forces a line in the 3D sketch to become normal to the
selected plane. To use this relation, invoke the Add Relations PropertyManager.

Select the line in the 3D sketch and a plane and choose the AlongZ button from
the Add Relations rollout.

Tangent
e The Tangent relation forces the selected arc, circle, spline, or ellipse to become
tangent to other arc, circle, spline, ellipse, line, or edge. To use this relation,
invoke the Add Relations PropertyManager. Select two entities to apply the
Tangent relation. Choose the Tangent button from the Add Relations rollout. Figures 3-4
and 3-5 show the entities before and after applying this relation.

Concentric
Concentric 1 e Concentric relation forces the selected arc or circle to share the same
centerpoint with other arc, circle, point, vertex, or a circular edge. To use
this relation, invoke the Add Relations PropertyManager. Select the required
entity to apply the Concentric relation. Choose the Concentric button from the Add Relations
rollout.

Midpoint
Midpoint The Midpoint relation forces the selected point to move at the midpoint of the
selected line. To use this relation, invoke the Add Relations PropertyManager.
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Select the required entity to apply the Midpoint relation. Choose the Midpoint button from
the Add Relations rollout.

Intersection
. The Intersection relation forces the selected point to move at the
x Interzection . . . . . .
intersection of the two selected lines. To use this relation, invoke the Add
Relations PropertyManager. Select the required entity to apply the
Intersection relation. Choose the Intersection button from the Add Relations rollout.

Coincident
- The Coincident relation forces the selected point to be coincident with the
Coincident . . . . . .
selected line, arc, circle, or ellipse. To use this relation, invoke the Add
Relations PropertyManager. Select the required entity to apply the
Coincident relation. Choose the Coincident button from the Add Relations rollout.

Equal
The Equal relation forces the selected lines to have equal length and selected
IEI Equal . . .. . . .
arcs, circles, or an arc and a circle to have equal radii. To use this relation, invoke
the Add Relations PropertyManager. Select the required entity to apply the
Equal relation. Choose the Equal button from the Add Relations rollout.

Symmetric
' 2 The Symmetric relation forces two selected lines, arcs, points, and ellipses
T | Symmetric . .1 . . .
to remain equidistant from a center line. This relation also force the arcs to
have the same radii. To use this relation, invoke the Add Relations
PropertyManager. Select the required entity to apply the Symmetric relation and select a
centerline. Choose the Symmetric button from the Add Relations rollout.

Fix
Fix  1he Fix relation forces the selected entity to fix at the specified position. If you
apply this relation to a line or an arg, its location is fixed but you can change its size
by dragging the endpoints. To use this relation, invoke the Add Relations
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PropertyManager. Select the required entity to apply the Fix relation. Choose the Fix
button from the Add Relations rollout.

Pierce
Fiorce The Pierce relaFion forces a sketch point to be Coinc.ident Whel.‘e an axis, line,
arc, edge, or spline pierce the sketch plane. To use this relation, invoke the Add
Relations PropertyManager. Select the required entities to apply the Pierce
relation. Choose the Pierce button from the Add Relations rollout.

Merge Points
Merge The Merge Points relation forces two sketch points or endpoints to merge in a
single point. To use this relation, invoke the Add Relations PropertyManager.
Select the required entities to apply the Merge Points relation. Choose the Merge
Points button from the Add Relations rollout.

Tip. You can also apply the relations using the Properties PropertyManager.

Q / Using the left mouse button select the entities to add relation. When you select the

| entities, the Properties PropertyManager will be displayed. If you select a single

entity then the PropertyManager of that particular entity will be displayed. The

possible relations for the selected geometry will be displayed in the Add Relations

rollout. Choose the relation that you want to apply to the selected geometry. The
existing relation will be displayed in the Existing Relations rollout.

Another method of applying relations to the sketches is by selecting the entity or
entities on which you have to apply the relation and then right-clicking to display
the shortcut menu. The relation that can be applied to the selected entities will be
displayed in the shortcut menu. Choose the relation from the shortcut menu.

Automatic Relations

The automatic relations are applied automatically to the sketch while drawing. You can activate
the automatic relations option ifit is not available. Invoke the System Options - Sketch dialog
box by choosing Tools > Options > System Options > Sketch. The System Options - Sketch
dialog box is displayed. Select the Automatic Relations check box from the System Options -
Sketch dialog box and choose the OK button.

The automatic relations are applied to the entities while sketching. For example, you will notice
that when you specify the startpoint of the line and move the cursor horizontally toward the
right or left, a symbol H is displayed below the line cursor. This is the symbol of the Horizontal
relation that is applied to the line while drawing. If you move the cursor vertically downwards or
upwards, the V symbol for Vertical relation is displayed below the line cursor. If you move the
cursor to the intersection of two or more than two sketched entities, the intersection symbol
appears below the cursor. Similarly, other relations are also automatically applied to the sketch
while creating the sketch. The relations that are applied automatically are listed below:

1. Horizontal
2. Vertical
3. Coincident
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4. Midpoint

5. Intersection

6. Tangent

7. Perpendicular

Tip. You will observe that while sketching, two types of inferencing lines are displayed.
One is displayed in blue and the second in brown. The brown inferencing line
indicates that relation is applied automatically to the sketch. The blue inferencing
line indicates that no automatic relation is applied.

DIMENSIONING THE SKETCH

Toolbar: Sketch > Dimension
Menu: Tools > Dimension

After drawing the sketches and adding the relations, dimensioning is the most important
ﬂ step in creating a design. As mentioned earlier, SolidWorks is a parametric software.

The parametric nature of SolidWorks ensures that irrespective of the original size, the
selected entity is driven by the dimension value that you specify. Therefore, when you apply and
modity a dimension on an entity, it is forced to change its size in accordance with the specified
dimension value. The type of dimension that will be applied depends on the type of entity
selected. For example, if you select a line, linear dimension will be applied and if you select a
circle, diametric dimension is applied. Similarly, if you select an arc, a radial dimension is
applied. While dimensioning, you can set the priority to edit the dimension value as soon as you
place it. To set this priority, choose Tools > Options to display the System Options - General
dialog box. Select the Input dimension value check box and choose OK.

Now, when you select an entity to apply the dimension, the Modify dialog box will be displayed,
as shown in Figure 3-6, as soon as you place the dimension. You can enter a new value in this box
to modify the dimension.

Modify
Textbox — MR~ =
| %] 8]29|
Save the current value — Spin hn}{.ar.ruws
and exit the dialog. Reset spin increment value.
Restore the ariginal value Regenerate the maodel
and exit the dialog. with the current value.

Figure 3-6 Modify box

You can modify the default dimension value using the spinner arrows or by entering a new value
in the text box available in the Modify dialog box. The buttons available in the Modify dialog
box are discussed next.

The Save the current value and exit the dialog button is used to accept the current value and
exit the dialog box. The Restore the original value and exit the dialog button is used to restore
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the last dimensional value applied to the sketch and exit the dialog box. The Regenerate the
model with the current value button is used to preview the geometry of the sketch with the new
modified dimensional value. The Reset spin increment value button is used to enter a new
spin increment value. This is the value that is added or subtracted from the current value when
you click once on the spinner arrow. When you choose this button the Increment dialog box is
displayed as shown in Figure 3-7.

Increment )

[ Make Default

Figure 3-7 Increment box

Insert a new value in the text box provided in the Increment dialog box and press ENTER. If
you select the Make Default check box, the new increment value will become the default spin
increment value. By default, 10 mm is the default increment value while working with metric
units. Next time when you modify the dimension using the spin increment arrows, the dimension
will increase or decrease with the increment value that you saved as the default value.

Tip. You can also enter the arithmetic symbols divectly into the text box to calculate
the dimension. For example, if you have a dimension as a complex arithmetic function
such as (220%12.5)-3+150, which is equal to 1247, you do not need to calculate
this using the calculator. Just enter the statement in the text box provided in the
Modify Dimension dialog box and press ENTER. SolidWorks will automatically
solve the function to get the value of the dimension.

Linear Dimensioning

Linear dimensions are defined as the dimensions that define the shortest distance between two
points. You can apply the linear dimension directly to a line, two points, or two objects. The
points can be the endpoints of lines or arcs, or the centerpoints of circles, arcs, ellipses, or
parabolas. You can dimension a vertical or a horizontal line by directly selecting them. Choose
the Dimension button from the Sketch toolbar or right-click in the drawing area. Choose the
Dimension option from the shortcut menu to activate the Dimension tool. When you move the
cursor on the line, it is highlighted and turns red in color. As soon as you select the line, it turns
to green, and the dimension is attached to the cursor. Move the cursor and place the dimension
at an appropriate place using the left mouse button. Since you have already set the priority of
editing the dimension as it is placed, the Modify dialog box is displayed with the default value
in it. Enter the new value of dimension in the Modify dialog box and press ENTER. Figure 3-8
shows linear dimensioning of horizontal and vertical lines.
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line and a vertical line

Figure 3-8 Linear dimensioning of lines

If the dimension is selected in the drawing area, the Dimension PropertyManager is displayed
at the left of the drawing area as shown in Figure 3-9. The various options available in the
Dimension PropertyManager are discussed next.

Part Favorite

The Part Favorite rollout is used to create, save, delete, and retrieve the dimension style in the
current document. You can also retrieve the dimensions styles saved earlier using this rollout.
The Part Favorite rollout is shown in Figure 3-10. The options available in this rollout are
discussed next:

Apply the default attributes to selected dimensions

The Apply the default attributes to selected dimensions button is used to apply the default
attributes to the selected dimension or dimensions. The attributes include the tolerance,
precision, arrow style, dimension text, and so on. This option is generally used when you
have modified the settings applied to a dimension and then you want to restore the default
settings on that dimension.

Add or Update a Favorite

The Add or Update a Favorite button is used to add a dimension style to the current
document for a selected dimension. After invoking the Dimension PropertyManager, set
the attributes using various options provided in this PropertyManager. Now choose the
Add or Update a Favorite button. The Add or Update a Favorite dialog box is displayed in
Figure 3-11. Enter the name of the dimension style in the edit box and press ENTER or
choose the OK button from this dialog box. The dimension style will be added to the
current document.

You can apply the new dimension style to the selected dimension by selecting the dimension
style from the drop-down list in the Part Favorite rollout. You can also update the dimension
style. To update a dimension style, select the dimension and set the options of the dimension
style according to your need and then choose the Add or Update a Favorite button to
invoke the Add or Update a Favorite dialog box. Select the dimension style to update from
the drop-down list provided in the dialog box. The two radio button in this dialog box are
enabled. Select the Update all the annotations linked to this favorite radio button and
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Figure 3-9 The Dimension PropertyManager
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Figure 3-10 The Part Favorite rollout
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Figure 3-11 The Add or Update a Favorite dialog box

choose the OK button to update all the dimensions linked with the selected favorite. If you
select the Break all links to this favorite radio button and choose the OK button to update
the dimension style used in the selected dimension, then the link between the other
dimensions having the same favorite and the selected favorite will be broken.

Delete a Favorite

The Delete a Favorite button is used to delete a dimension style. Select the dimension style
or favorite from the Set a current Favorite drop-down list and choose the Delete a Favorite
button. Note that even after you delete the dimension style, the properties of the dimensions
will be the same as with the deleted favorite. You can set the properties of a dimension to the
document default using the Apply the default attributes to the selected dimension button.

Save a Favorite

The Save a Favorite button is used to save a dimension style so that it can be retrieved in
some other document. Select the dimension style or favorite from the Set a current Favorite
drop-down list and choose the Save a Favorite button. The Save As dialog box will be
displayed. Browse the folder in which you want to save the favorite and enter the name of
the favorite in the File name edit box. Choose the Save button from the Save As dialog box.
The extension for the file in which the favorite is saved is .sldfut.

Load Favorite

The Load Favorite button is used to open a saved favorite in the current document and the
properties of that favorite will be applied to the selected dimension. To load a favorite,
choose the Load favorite button to invoke the Open dialog box. Browse the folder in which
the favorite is saved. Now, select the file with the extension .sldfot and choose the Open
button. The Add or Update a Favorite dialog box is displayed. Choose the OK button from
this dialog box.

Tip. You can load more than one favorite by pressing the CTRL key and selecting the
favorites from the Open dialog box. All the favorites will be displayed in the Set a
current Favorite drop-down list.

Tolerance/Precision

The Tolerance/Precision rollout is used to specify the tolerance and precision in the dimensions.
This rollout is shown in Figure 3-12. The various options available in the Tolerance/Precision
rollout are discussed next.
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Figure 3-12 The Tolerance/Precision rollout

Tolerance Type

The Tolerance Type drop-down list is used to apply the tolerance to the dimension.
Various tolerance methods are available in this list. By default, the None option is selected,
which means that tolerance is not applied to the dimension. The other tolerance methods
available in the Tolerance Type drop-down list are discussed next.

a5
=
*
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Basic

The Basic option is used to display the basic dimension. To display a basic dimension,
select a dimension that you want to display as a basic dimension and then select the
Basic option from the Tolerance Display drop-down list. You will notice that the
dimension is enclosed in a rectangle, suggesting that it is a basic dimension. The basic
dimension is shown in Figure 3-13.

Bilateral

The Bilateral option is used to display the bilateral tolerance along with the dimension.
This type of tolerance provides the maximum and the minimum variation in the value
of the dimension that is acceptable in the design. For applying the bilateral tolerance,
select the dimension and then select the Bilateral option from the Tolerance Type
drop-down list. The Maximum Variation and the Minimum Variation edit boxes are
enabled. These edit boxes are used to apply the value of the maximum and minimum
variation to a dimension. If you select the Show parentheses check box, the bilateral
tolerance will be displayed with parentheses. This check box is available when you
apply the bilateral tolerance. The dimension with bilateral tolerance is shown in
Figure 3-14.

Note
The dimension standard used in the drawings in this book s the ISO standard.

Limit

The Limit option is used to display the limits with the dimension. In the limit dimension,
the dimension is displayed as its maximum and minimum values that are allowed in the
design. Select the dimension to display as limit dimension and select the Limit option.
The Maximum Variation and the Minimum Variation edit boxes are enabled to enter
the value of maximum and minimum variation. The dimension along with limit tolerance
is shown in Figure 3-15.
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Figure 3-13 Basic dimension Figure 3-14 Bilateral tolerance

Symmetric

The Symmetric option is used to display the symmetric dimensional tolerance. This
type of tolerance is displayed with plus and minus sign. To use this tolerance, select the
dimension and select the Symmetric option. The Maximum Variation edit box will be
displayed to enter the value of tolerance. You can select the Show parentheses check
box to show the tolerance in parentheses. The dimension along with the symmetric
tolerance is shown in Figure 3-16.
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220050
215570 260 0,020
Figure 3-15 Limit tolerance Figure 3-16 Symmetric tolerance

MIN

The MIN option in the Tolerance Type drop-down list is used to display the minimum
allowable value of the dimension. In this type of dimensional tolerance, the min. symbol
is added to the dimension as a suffix. This implies that the dimensional value is the
minimum value that is allowable in the design. To display this dimensional tolerance,
select the dimension and select the MIN option from the Tolerance Type drop-down
list. The dimension along with the minimum tolerance is shown in Figure 3-17.
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MAX

The MAX option in the Tolerance Type drop-down list is used to display the maximum
allowable value of the dimension. In this type of dimensional tolerance, the max. symbol
is added to the dimension as suffix. This implies that the dimensional value is the
maximum value that is allowable in the design. To display this dimensional tolerance,
select the dimension and select the MAX option from the Tolerance Type drop-down
list. The dimension along with the maximum tolerance is shown in Figure 3-18.

c %

£ £
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& g = é
E E
2 2

220 min. 220 max.
Figure 3-17 Minimum tolerance Figure 3-18 Maximum lolerance
Fit

The Fit option is used to apply the fit according to the Hole Fit and the Shaft Fit
system. The Tolerance/Precision rollout with the Fit option selected is
shown in Figure 3-19. Specity the type of fit from the Classification drop-down list.
The Classification drop-down list is used to define User Defined fit, Clearance fit,
Transitional fit, and Press fit. To apply the fit using the hole fit system or the shaft fit
system, select the dimension and select the Fit option from the Tolerance Type drop-down

T olerancesPrecizion rs

i fFit = |—Tolerance Type
I ) [—— Tl—Classification
[on] | = |—Hole Fit

v | ~|-—Shatt Fit

Stacked with . . .
line displayed @ ! Stackedl without line displayed
Linear display

Primary Unit F'reclsmn—HHHH | [ Default]

Tolerance F'reclsmn—ﬁu_mc | e [Default] j

Figure 3-19 The Tolerance/Precision rollout with the Fit option selected from the
Tolerance Type drop-down list.

‘ c03-solidworks-2003.p65 15 5/12/2003, 9:44 AM



3-16

SolidWorks for Designers

list. The Classification drop-down list, the Hole Fit drop-down list, and the Shaft Fit
edit drop-down list are displayed below the Tolerance Type drop-down list. Choose the
type of fit from the Classification drop-down list and select the standard of fit from the
Hole Fit drop-down list or the Shaft Fit drop-down list. If you choose the Clearance,
Transitional, or Press option from the Classification drop-down list and you choose
the standard of fit from the Hole Fit drop-down then only the standards that match
with the selected hole fit will be displayed in the Shaft Fit drop-down list and vice-versa.
Ifyou choose the User Defined option from the Classification drop-down list then you
can choose any standard from the Hole Fit and the Shaft Fit drop-down lists.

The Stacked with line display button provided under the Shaft Fit drop-down list is
selected by default. You will notice that the tolerance is displayed as stacked with a line.
You can also display the tolerance as stacked without a line using the Stacked without
line display button. If you choose the Linear display button, the tolerance will be
displayed in linear form. The dimension along with the hole fit and the shaft fit is
shown in Figure 3-20.

Fit with tolerance

The Fit with tolerance option in the Tolerance Type drop-down list is used to display
the tolerance along with the hole fit and shaft fit in a dimension. To apply the fit with
the tolerance, select the dimension and select the Fit with tolerance option from the
Tolerance Type drop-down list. Choose the type of fit from the Classification drop-down
list. Now, select the fit standard from the Hole Fit drop-down list or the Shaft Fit
drop-down list. The tolerance will be displayed with the fit standard only if you select
only one fit system either from the hole drop-down list or from the shaft drop-down list.
The tolerance will be displayed along with the fit standard in the drawing area. In this
release of SolidWorks the tolerance is calculated automatically depending upon the
type of fit selected and the standard of fit selected. The show parentheses check box is
available, and you can select this check box if you want to show the parentheses. The
dimension along with fit and tolerance is shown in Figure 3-21.

Note

9 . . . . . . . .
> d The diametrical dimension will be discussed later in this chapter.
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Primary Unit Precision

The Primary Unit Precision drop-down list is used to specify the precision of the number
of places after the decimal for dimensions. By default, the selected precision is two places
after the decimal.

Tolerance Precision

The Tolerance Precision drop-down list is used to specify the precision of the number of
places after the decimal for tolerance. By default, the selected precision is two places after
the decimal.

Arrows
The Arrows rollout is used to specify the arrow style in the dimensions. The Arrows rollout is
shown in Figure 3-22. Various options available in this rollout are discussed next.

Ingide

Arrows Es

Outside %*Sman

I—Eb [y w|—5tyle

Figure 3-22 The Arrows rollout

Outside

The Outside button available in the Arrows rollout is used to display the arrows outside the
dimension line. Select a dimension from the drawing area and choose the Outside button
from the Arrows rollout.

Inside

The Inside button available in the Arrows rollout is used to display the arrows inside the
dimension line. Select a dimension from the drawing area and choose the Inside button
from the Arrows rollout.

Smart

The Smart button available in the Arrows rollout is used to display the dimension inside or
outside the dimension line, depending on the surrounding geometry. The Smart button is
selected by default in the Arrows rollout.

Style

The Style drop-down list is used to select the arrowhead style. The unfilled triangular arrow
is select by default. You can select any arrow style for a particular dimension or dimension
style. To change the arrow style, select the dimension from the drawing area and choose the
arrow style from the Style drop-down list.

Dimension Text
The Dimension Text rollout is used to add the text and symbols in the dimension. The Dimension
Text rollout is displayed in Figure 3-23. Three text boxes are provided in this rollout. These
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three text boxes are the three lines in which the text or symbols ;. 1 . "

can be added. The first text box in this rollout is used to enter the
text or symbols in the first line, which is above the dimension I
value. The second text box is used to enter the text or symbols in |<D"u'|>
the second line, in which the dimension is also displayed in the
second line. The third text box is used to enter the text or symbols
in the third line, which is below the dimension value.

In this rollout various buttons are provided to add the symbols =
such as Diameter, Degree, Plus/Minus, Centerline, and so on to |:

the dimension text. You can invoke the Symbols dialog box to add IEIII“EI

more symbols by choosing the More Symbols button from the

Dimension Text rollout. The Symbols dialog box is displayed in

Figure 3-24.

Figure 3-23 Dimension Text

Symbols E rollout

Sumbal librany:

IModif_l,ling Symbols j

Cancel |
Deagree |
Diameter Ll

Free State(S)

Free State(F)

Least Matenal Condition

b axirurn b aterial Condition
Frojected Taolerance Zone q;_
Encompazsing

FlusMinus ;I

& Use Symbal T Mo Symbal

Figure 3-24 The Symbols dialog box

The More Properties button is used to invoke the Dimension Properties dialog box to modify
the properties of the dimension. All the options available in the Dimension PropertyManager
are available in the Dimension Properties dialog box with some additional options. You can
modify the dimension properties from the Dimension PropertyManager or from the
Dimension Properties dialog box.

Linear Dimensioning Between Points

You can add a linear dimension between two points; one point can be a sketch point, an endpoint,
or a centerpoint and the second point can be a sketch point, an endpoint, a centerpoint, an
origin, or avertex. For creating the linear dimension between two points, choose the Dimension
button from the Sketch toolbar. Select the first point, and then select the second point. Move
the cursor to the right or left of the sketched entities to get the vertical dimension or move the
cursor to the top or bottom of the sketched entities to get the horizontal dimension. Specity a
point to place the dimension. The Modify dialog box will be displayed. Enter a new dimension
value in this dialog box and press ENTER. Figures 3-25 and 3-26 show the horizontal and
vertical linear dimensioning between points.
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ORCH
o

/Tg

Horizontal Vertical ——50

dimensioning dimensioning Horizontal dimensioning Vertical dimensioning

between two points ~ between two points of an inclined line of an inclined line
Figure 3-25 Linear dimensioning between points Figure 3-26 Linear dimensioning of lines

Linear Dimensioning of a Circle

You can also dimension a circle using the linear dimensioning method. Sketch the circle and
choose the Dimension button from the Sketch toolbar. Using the left mouse button, select the
circle. The dimension will be attached to the cursor. If you want to create the vertical
dimension, move the cursor to the right or left of the sketch. If you want to create the horizontal
dimension, move the cursor to the top or bottom of the sketch. Using the left mouse button,
place the dimension and enter a new value in the Modify dialog box. The linear dimensioning
of the circle is shown in Figure 3-27.

Aligned Dimensioning

Aligned dimensions are used to dimension lines that are at an angle with respect to the X axis
and the Y axis. This type of dimensioning measures the actual distance of the inclined lines.
You can directly select the inclined line to apply this dimension or select two points. The points
that can be used to apply aligned dimension include the endpoints of line, arc, parabolic arc, or
spline and the centerpoints of arcs, circles, ellipse, or parabolic arc. To apply an aligned
dimension to an inclined line, choose the Dimension button from the Sketch toolbar and select
the line. Move the cursor at an angle such that the dimension line is parallel to the inclined
line. Using the left mouse button place the dimension at an appropriate place and enter a new
value in the Modify dialog box.

To apply an aligned dimension between two points, choose the Dimension button and select the
first point to which you have to apply the dimension. Now select the second point to apply the
dimension. The dimension will be attached to the cursor. Move the cursor such that the dimension
line is parallel to the imaginary line that joins two points. Now, using the left mouse button
place the dimension at an appropriate location and enter a new value in the Modify edit box
and press ENTER. Figure 3-28 shows the aligned dimensioning of a line and an aligned dimension
between two points.

Angular Dimensioning

Angular dimensions are used to dimension angles. You can select two line segments to apply the
angular dimensions or use three points to apply the angular dimensions. You can also use angular
dimensioning to dimension an arc. All these options of angular dimensioning are discussed next:
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2100

#100
Linear dimensioning Aligned dimensioning of inclined line and
of circle between two points
Figure 3-27 Linear dimensioning of circle Figure 3-28 Aligned dimensioning

Angular Dimensioning Using Two Line Segments

You can select two line segments to apply angular dimensions. Choose the Dimension button
from the Sketch toolbar and select the first line segment using the left mouse button. A dimension
is attached to the cursor. Now, select the second line segment. An angular dimension will be
attached to the cursor. Place the angular dimension and enter the new value of angular dimension
in the Modify edit box. You have to be very careful while placing the angular dimension. This is
because depending upon the location of the dimension placement, the interior angle, exterior
angle, major angle, or minor angles are displayed. Figures 3-29 through 3-32 illustrate various
angular dimensions depending upon the dimension placement point.

First First
entity entity
/ O
Dimension ZSecomd Dimension
/iitc.?nd placement entity p\qcememt
4 point point
Figure 3-29 Angular dimension displayed Figure 3-30 Angular dimension displayed
according to the dimension placement point according to the dimension placement point

Angular Dimensioning Using Three Points

You can also apply angular dimensions using three points. Choose the Dimension button from
the Sketch toolbar. Select the first point using the left mouse button. This is the angle vertex
point. Select the second point. A linear dimension is attached to the cursor. Next, select the
third point; an angular dimension is attached to the cursor. Place the angular dimension and
enter a new value of angular dimension in the Modify edit box. The points that can be used to
apply the angular dimensions include the endpoints of lines or arcs, centerpoint of circles, and
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. First
First entity
entity
Second
\Secomd entity
entity

Figure 3-31 Angular dimension displayed Figure 3-32 Angular dimension displayed
according to the dimension placement point according to the dimension placement point

endpoints of ellipse, parabola, and so on. Figure 3-33 shows the angular dimensioning using
three points.

Angular Dimensioning of an Arc

You can use angular dimensions to dimension an arc. In case of arcs, the three points that
should be used are the endpoints of the arc and the centerpoint of the arc.
Figure 3-34 shows the angular dimensioning of an arc.

Third
point

\Second

point

First
point

Figure 3-33 Angular dimension displayed Figure 3-34 Angular dimension displayed
according to the dimension placement point according to the dimension placement point

Diameter Dimensioning

Diameter dimensions are applied to dimension a circle or an arc in terms of its diameter. For
creating a diameter dimension, choose the Dimension button from the Sketch toolbar and
select the entity to add the diametrical dimension. Now, using the left mouse button, place the
dimension. In SolidWorks, when you select a circle to dimension by default, the diameter
dimension is applied to it. However, when you select an arc, the radius dimension is displayed
to an arc. To apply the diameter dimension to an arc, select the arc and place the radius
dimension. Next right-click to display the shortcut menu and choose the Properties option
from the shortcut menu. The Dimension Properties dialog box is displayed. Select the Diameter
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dimension check box and choose OK. Figure 3-35 shows a circle and an arc with the diameter
dimension.

Radius Dimensioning

Radius dimensions are applied to dimension a circle or an arc in terms of its radius. As mentioned
earlier, by default the dimension applied to a circle is in the diameter form and the dimension
applied to an arc is a radius dimension. To apply radius dimension, choose the Dimension
button from the Sketch toolbar and select the arc. A radius dimension will be attached to the
cursor. Using the left mouse button place the dimension at an appropriate place. To convert
the radius dimension to the diameter dimension you need to select the Diameter dimension
check box from the Dimension Properties dialog box. Figure 3-36 illustrates the radial
dimensioning of a circle and an arc.

Q

(&) S Q
5 S S S
) N &
) o9’

Diameter Diameter E.Qd@ o Egdio\ o
dimensioning dimensioning imensioning imensioning

. of a circle of an arc

of a circle of an arc

Figure 3-35 Diametrical dimensioning of a circle Figure 3-36 Radial dimensioning of a circle and
and an arc an arc

Linear Diameter Dimensioning

Linear dimensioning is used to dimension the sketch of a revolved component. An example of
arevolved component is shown in Figure 3-37. The sketch for a revolved component is drawn
using simple sketcher entities as shown in Figure 3-38. If you dimension the sketch of the base
feature of the given model using the linear dimensioning method then the same dimensions will
be generated in drawing views. This may be confusing because in the shop floor drawing, you
need diameter dimension of a revolved model. To overcome this problem, it is recommended
that you create a linear diameter dimension as shown in Figure 3-38. For creating the linear
diameter dimension, choose the Dimension button from the Sketch toolbar. Select the entity to
be dimensioned and then select the center line around which the sketch will be revolved. Move
the cursor to the other side of the centerline. A linear diameter dimension is displayed. Using
the left mouse button place the dimension and enter a new value in the Modify dialog box.

Additional Dimensioning Options

In SolidWorks, you are also provided with some other dimensioning options other than those
discussed earlier. The main additional dimensioning option is discussed next.
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Linear diameter
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Figure 3-38 Skeich for the revolved feature and
linear diameter dimension

Figure 3-37 A revolved component

Dimensions Between Arcs or Circles

By default, the dimension between two arcs, two circles, or between an arc and a circle is placed
from centerpoint to centerpoint. For dimensioning two circles, choose the Dimension button
from the Sketch toolbar and using the left mouse button select the first circle. A diameter
dimension is attached to the cursor. Now, select the second circle. A linear dimension between
the centerpoints of two circles is attached to the cursor; place the dimension using the left mouse
button. Enter a new value of dimension in the Modify edit box and press ENTER. Figure 3-39
shows the dimensioning of two circles using this method.

First Second
entity entity

Dimension
placement
point

86
I |

Figure 3-39 Dimension with first arc condition as
Center and second arc condition as Center

Tip. You can also choose Tools > Dimension > Parallel / Horizontal / Vertical
to add the dimensions to the sketch instead of using the Dimension button from the
Sketch toolbar. But it is recommended that you use the Dimension button because
using this button you can create any type of dimension whether it is a parallel,
horizontal, vertical, diametrical, or radial dimension. In this book you will be
using the Dimension button to dimension the sketches.

Now, right-click to display the shortcut menu. Choose the Properties option from the shortcut
menu to display the Dimension Properties dialog box. You will notice that in the Dimension
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Properties dialog box, the Center radio buttons are selected in the First arc condition : and
Second arc condition : areas. Therefore, the dimension displayed using this combination is the
dimension between the centerpoint between two circles or arcs. If you choose the Min radio
button from the First arc condition : area and the same from the Second arc condition : area,
the resultant dimensioning will be displayed as the minimum distance between two circles or
arcs as shown in Figure 3-40. If you select the first arc condition Max and also the second arc
condition as Max, the dimensional value will be displayed as the maximum distance between
two circles as shown in Figure 3-41. Similarly, you can adjust the first end condition and the
second end condition accordingly.

33 139

Dimension with First end comdition as

Min and Second end condition as Min Dimension with First end comdition as

Max and Second end condition as Max

Figure 3-40 Dimension with first and second Figure 3-41 Dimension with first and second
arc condition as Min arc condition as Max

CONCEPT OF FULLY DEFINED SKETCH

It is very necessary for you to understand the concept of fully defined sketches. While creating a
model, first you have to draw the sketch for the base feature and then proceed further for
creating other features. This is the reason sketching is the basic concept of modeling. After
creating the sketches, you have to add the required relations and dimensions to constrain the
sketch with respect to the surrounding environment. After creating the sketch and adding the
required relations and dimensions, the sketch may exist in one of the six states. The six states of
the sketch are discussed below:

Fully Defined

Over Defined

Under Defined
Dangling

No Solution Found
Invalid Solution Found

SN

Fully Defined

A fully defined sketch is a sketch in which all the entities of the sketch and their positions are
tully defined by the relations or dimensions, or both. In the fully defined sketch, all the degrees
of freedom of a sketch are constrained using relations and dimensions and the sketched entities
cannot move or change their size and location unexpectedly. If the sketch is not fully defined, it
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can change its size or position at any time during the design because all the degree of freedom
are not constrained. A fully defined sketch is displayed in black.

Over Defined

An over defined sketch is a sketch in which some of the dimensions, relations, or both are
conflicting or the dimension or relations in the sketch have exceeded the required number. The
over defined sketch is displayed in red. The over defined sketch geometry is constrained by too
many dimensions and/or relations. Therefore, you need to delete the extra and conflicting
relations or dimensions. It is recommended that you do not proceed further for creating the
teature with an over defined sketch. The over defined sketch is solved to fully defined or under
defined sketch by deleting the conflicting relations or dimensions. Deleting the over defining
relations or dimension is discussed later in this chapter.

Under Defined

An under defined sketch is a sketch in which some of the dimensions or relations are not
defined and the degree of freedom of the sketch is not fully constrained. In the under defined
sketch, the dimensions and relations are not defined adequately and entities may move or
change size unexpectedly. The sketched entities of the under defined sketch are displayed in
blue. This is the reason the sketch is displayed in blue while drawing. This means the sketch is
under defined and it needs some relations and dimensions to constrain its degree of freedom.
When you add the relations and dimensions, the sketch changes to black color, suggesting that
the sketch is fully defined. If the entire sketch is in black and only some of the entities are shown
in blue, this means that the entities in blue require some dimension or relation.

™ Tip. In SolidWorks, it is not necessary that you fully dimension or define the

Xe' 4 sketches before you use them to create the featwres of the model. However, it is

W recommended that you fully define the sketches before you proceed further for creating
the feature.

If you want to always use fully defined sketches before proceeding further, you can
set the option by choosing Tools > Options from the menu bar to display the
System Option - General dialog box. Choose the Sketch option from the System
Options tab. Select the Use fully defined sketches check box and choose OK from
this dialog box.

». Note
5N H From this chapter onwards, you will work with fully defined sketches. Therefore, follow the above
g procedure to use the fully defined sketches in future.

Dangling
In the dangling sketch, the dimensions or relations lose their reference because of the deletion

of an entity from which it was referenced. These entities are displayed dashed in brown color.
You need to delete the dangling entities, dimensions, or relations that conflict.

No Solution Found

In the no solution found state, the sketch is not solved with the current constraints. Therefore,
you need to delete the conflicting dimensions or relations and add other dimensions or relations.
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Tip. The status bar of the SolidWorks window is divided into four areas while
working in the sketching environment. The Sketch Definition area of the status
bar always displays the status of the sketch, dimension, and relation. If the sketch is
under defined the status area will display the Under Defined message; if the sketch
is over defined then the message displayed in the status area will be Over Defined;
if the sketch is fully defined then the message displayed in the status area will be
Fully Defined.

The sketched entity, dimension, or relation will be displayed in pink.

Invalid Solution Found

In the invalid solution found state, the sketch is solved but the sketch will result in invalid
geometry such as a zero length line, zero radius arc, or self-intersecting spline. The sketch
entities for this state are displayed in yellow.

Sketch Dimension or Relation Status

In SolidWorks when you are applying the dimensions and relations to the sketches, sometimes
you apply the dimensions or relations that are not compatible with the geometry of the sketched
entities or that make the dimensioned entity over defined. The sketch dimensions or relations
may have any of the following states:

Dangling

Satisfied

Over Defining

Not Solved

Driven

SUR 0o =

Dangling
A dangling dimension or relation is the one that cannot be resolved because the entity to which
it was referenced is deleted. The dangling dimension appears in brown color.

Satisfied

A satisfied dimension is the one that is completely defined and is displayed in black.

Over Defining
An over defining dimension or relation overdefines one or more entities in the sketch. The over
defining dimension appears in red.

Not Solved

The not solved dimension or relation is not able to determine the position of the sketched
entities. A not solved dimension appears in pink.

Driven
The driven dimension’s value is driven by other dimensions in the sketch that solve the sketch.
The driven dimension appears in gray.
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DELETING THE OVER DEFINING DIMENSIONS

In SolidWorks, when you add a dimension that over defines a sketch, the sketch and dimension
turns red. Also, the SolidWorks warning window is displayed as shown in Figure 3-42.

Sohdworks E

& Thiz dimenzion iz over defined. Itz value cannot be changed.

Figure 3-42 The box warning you about over defined dimensions

Choose the OK button from this window. The Make Dimension Driven? dialog box is displayed
as shown in Figure 3-43. If you select the Make This Dimension Driven radio button from this
dialog box and choose OK, then that dimension will become a driven dimension. The driven
dimension is displayed in gray and you cannot modify a driven dimension. Its value depends
upon the value of the driver dimension. If you change the value of the driver dimension, the
value of the driven dimension will be automatically changed.

Make Dimension Dnven? EE

Adding thiz dimenzion will make the sketch over defined or
unable to solve, Do vou want to add it 3z a diiven dimension
inztead?

& Make This Dimension Driveri

" Leave This Dimension Driving Cancel |

Figure 3-43 The Make Dimension Driven? dialog box

Ifyou select the Leave This Dimension Driving radio button from the Make Dimension Driven?
dialog box and choose OK, then some of the entities and dimension in the sketch will be
displayed in red. You need to delete either the red sketched entity or the red dimension to make
sure the sketch is no more over defined. The SolidWorks information dialog box will be displayed
as shown in Figure 3-44 when you delete the over defining entity or dimension. The message
displayed in this dialog box is The sketch is no longer over defined. Choose OK from the
SolidWorks information dialog box. The sketch will be displayed in black, which indicates that
the sketch is fully defined.

Solidworks E3

& The sketch iz no longer over defined.

Figure 3-44 The SolidWorks information dialog box
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You can also prevent the sketch from being over defining by choosing the Cancel button from
the Make Dimension Driven? dialog box. If you choose Cancel from the Make Dimension
Driven? dialog box, then the SolidWorks information dialog box will be displayed, as shown
above, with a message displaying The sketch is no longer over defined.

Displaying and Deleting Relations

Toolbar: Sketch Relations > Display/Delete Relations
Menu: Tools > Relations > Display/Delete

If the sketch is over defined after adding the dimensions and relations, then you need to
% delete some of the over defining, dangling, or not solved relations or dimensions. You

can view the relations applied to the sketch using the Sketch Relations PropertyManager.
You can also delete the unwanted relations using this PropertyManager. To invoke the Sketch
Relations PropertyManager, choose the Display/Delete Relations button from the Sketch
Relations toolbar. You can also right-click in the drawing area to display the shortcut menu and
choose the Display/Delete Relations option. The Sketch Relations PropertyManager will be
displayed as shown in Figure 3-45. The confirmation corner is also displayed at the upper right
corner of the drawing area. The options available in the Sketch Relations PropertyManager
are discussed next.

Relations

The Relations rollout is used to check, delete, and suppress the unwanted and conflicting
relations. The status of the sketch or the selected entity is displayed in the Information area of
this rollout. The various options of the Relations rollout are discussed next.

Filter

The Filter drop-down list is used to select the filter to show the relations in the Sketch
Relation PropertyManager. The various options available in the Filter drop-down list are
discussed next.

All in this sketch

The All in this sketch option is used to display all the relations applied to the sketch.
This option is selected by default in the Filter drop-down list. The first relation displayed
in the list will be selected by default and will appear with blue background. The status of
the selected relations is displayed in the Information area of the Relations rollout. The
overdefined relations are highlighted in red color. If you select a relation highlighted
red in color in the Relations area, you will notice that the status of the selected relation
is displayed as Over Defining. The dangling relation is highlighted in brown. When
you select the dangling relation, the status of the relation will be displayed as Dangling
in the Information area. Similarly, the not solved relation will be highlighted in yellow
and the driven relation in gray.

\o‘j;?:; Tip. When you move the cursor on the relations displayed in the Relations area of
Q / the Relations rollout, the tooltip will inform you about the type of relation.
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Figure 3-45 The Sketch Relations PropertyManager

Dangling
The Dangling option is used to display only the dangling relations applied to the
sketch.

Overdefining/Not Solved

The Overdefining/Not Solved option is used to display only the over defining and not
solved relation. The dangling relations are also not solved relations. Therefore, they
will also be displayed.

External

The External option is used to display the relations that have a reference with an entity
outside the sketch. This entity can be an edge, vertex, or origin within the same model
or it can be an edge, vertex, or origin of a different model within an assembly.

Design In Context

The Design In Context option is used to display only the relations that are in the
context of a design. They are the relations between the sketch entity in one part and an
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entity in another part. These relations are defined while working with the top-down
assemblies.

Locked
The Locked option is used to display only the locked relations.

Broken
The Broken option is used to display only the broken relations.

Note
The Locked and the Broken velations are applied while creating a part within the assembly
environment. You will learn more about these relations in the later chapters.

Selected Entities

The Selected Entities option is used to select the entities to display the relations. When
you select this option from the Filter drop-down list, the Selected Entities area is
displayed in the Relations rollout. When you select an entity to display the relations,
the name of the selected entity is displayed in the Selected Entities area and the
relation applied to this entity is displayed in the relation. To remove the selected entity
from the selection set, select the entity to be removed and right-click to display the
shortcut menu. Choose the Delete option from the shortcut menu. If you choose the
Clear Selections option, all the entities will be removed from the selection set.

Suppressed

The Suppressed check box is selected to suppress the selected relation of the current
configuration. When you suppress a relation, the relation is displayed in gray in the Relations
area. The status of the suppress relation is displayed as Satisfied or Driven in the information
area. If you suppress over defining dimensions the SolidWorks information dialog box will
be displayed with a message that The sketch is no longer over defined. Choose the OK
button from this dialog box.

9
280
- H

(s

Note
The configurations used in the part and assembly modeling will be discussed in the later chapters.

Delete
The Delete button is used to delete the relation selected in the Relations area.

Delete All
The Delete All button is used to delete all the relations that are displayed in the Relations
area.

Undo last relation change
The Undo last relation change button is used to undo the Delete, Replace, and Suppressed
options used earlier. The replace option is discussed later in this chapter.

Entities
The Entities rollout is used to display the entities that are referred to in the selected relation.
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This rollout is also used to display the status of the selected relation ¢ .. -

and the external reference, if any. By default, the Entities rollout ~ ————— e
En... | Statuz | Define... |

is closed. Move the cursor to the black triangle at the right of the
Entities rollout. The Entities rollout is shown in Figure 3-46. The
various options in the Entities rollout are discussed next.

Entities used in the selected relation

The Entities used in the selected relation area is used to
display the information about entities used in the selected
relation. The information about the name of the entity, the
status of the entity, and the place where the entity is defined is
provided. This area is divided in three columns. The three
columns available in the Entities rollout are discussed nexct.

Entity.
The Entity column is used to display the entity or entities

on which the selected relation is applied.

Status.

Foi.. FullyD...  Current...
Poi.. FullkD... Same..

E ntity: |
Owner: |
.-’-'w&eml:uly:l

[Becteee ||

[ Replace in all relations

Figure 3-46 The Entities
rollout

The Status column is used to display the status of the selected relation. The status
displayed in the Status column can be Fully Defined, Dangling, Over Defined, or Not

Solved.

Defined In.

The Defined In column is used to display the placement of the entity. The entity can be

placed in any of the following places:

Current Sketch.

The Current Sketch option is displayed in the Defined In column when the entity

is placed in the same sketch.

J
=

Tip. By default the Override Dims on Drag option is selected from Tools >

value of dimension applied to the sketched entity will be changed automatically. If
you clear this option you cannot change a dimensioned sketched entity by dragging
because it will not override the dimension. However, if the sketch is not fully
defined, the entities that are not properly dimensioned or constrained will move.

S
W Sketch Settings menw in the menu bar. As a result, if you drag a sketched entity, the

By default, the Automatic Solve option is selected from the Tools > Sketch Settings
menuw in the menu bar. This option helps you to solve the relations and dimensions
automatically when you drag or modify a sketched entity. If you clear this option, a
message that The sketch cannot be dragged because Auto Solve Mode is off. To
drag the sketch, please turn the Auto Solve Mode on. appears. If you modify
the dimension value using the Modify dialog box, the dimension will not update
automatically, and you have to wpdate the new dimension manually. 1o wpdate and
solve the dimension you have to choose the Rebuild button from the Standard

toolbar or press CT'RL+B using the keyboard.
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Same Model.

The Same Model option is displayed in the Defined In column when the entity is
defined as placed in the same model. This means that the entity is placed in the
same model but outside the sketch. This entity can be an edge, vertex, or an origin
of the same model.

External Model.

The External Model option is displayed in the Defined In column when the
entity is placed in some other model but within the assembly. This entity can be the
edge, vertex, or the origin of a different model but in the same assembly.

Entity

The Entity display box is used to display the name of the entity and the name of the part in
which the selected entity is placed. This entity is selected in the Entity column of the
Entities used in the selected relation area. The selected entity is also highlighted in the
drawing area.

Owner
The Owner display box is used to display the name of model in which the entity is placed
when the External Model option is displayed in the Defined In column.

Assembly
The Assembly display box is used to display the path of the assembly in which the entity is
placed when the External Model option is displayed in the Defined In column.

Replace

The Replace button is used to replace the selected entity from the Entity column with some
other entity from the drawing area. When you select the entity from the drawing area, the
entity will be displayed in the display box provided below the Replace button. Choose the
Replace button to replace the entity. If the sketch is overdefined, you will be given a warning
message. Sometimes after replacing the entity, the status of the entity is changed to not
solved or overdefining. You need to undo the last operation. The Replace in all relations
check box is selected to replace the entity in all the relations.

VIEWING AND EXAMINING RELATIONS

You can view and examine the relations applied to the sketch. To view and examine the relations
applied to a particular entity, select that entity. The PropertyManager of that entity will be
displayed. The Existing Relations area will display the relations that are already applied to the
selected entity. The Information area will inform you about the status of the sketch. Select the
relations one by one from the Existing Relations area. The callout of the relations will be
displayed in the drawing area as shown in Figure 3-47. The callout that is displayed in the
drawing area is divided in two parts. The first part displays the symbol of the relation applied to
the selected entity and the second part displays the name of the entity. If you double-click the
relation symbol then the Sketch Relations PropertyManager will be displayed. You can analyze,
examine, and delete the unwanted, over defining, dangling, and not solved relations using this
option.
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. Line1a

P4

Figure 3-47 Callout of relations displayed in the drawing area

. Note
> A d To exit the callout, click anywhere on the screen.

&= Tip. You can also display the relation callouts in the drawing area without invoking
\¢ 4 the Sketch Relations PropertyManager. Double-click on the sketched entity and
?/ the relation callouts will be displayed in the drawing area.

OPENING AN EXISTING FILE

Toolbar: Standard > Open
Menu: File > Open

=| The Open dialog box is used to open an existing SolidWorks part, assembly, or drawing

L& | Jocument. You can also use this dialog box to import files from other applications saved

in some standard file formats. Choose the Open button from the Standard toolbar, or

press CIRL+O keys to invoke the Open dialog box. The Open dialog box is shown in
Figure 3-48. Various options available in this dialog box are discussed next.

Look in drop-down list
The Look in drop-down list is used to specify the drive or directory in which the file is saved.
The location of the file and the folder that you browse is shown in this drop-down list.

File name
The name of the file selected is shown in the File name edit box. You can also enter the name of
the file to open in this edit box.
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Figure 3-49 The Open dialog box

Files of type

The Files of type drop-down list is used to specify the type of file to open. Using this drop-down
list, you can select a particular type of file type such as the part file, assembly file, drawing file,
all SolidWorks files, and so on. You can also define the file standard format in this drop-down
list to import the files saved in those file formats. You will learn more about importing the files
in the later chapters.

Open as read-only

The Open as read-only option is selected to open the document as a read only file. This option
is available after invoking the flyout by selecting the down arrow available at the right of the
Open button. If you modify the design in a read-only file, the changes are saved in a new file.
The original file is not modified. This also allows another user to access the document while
the document is open on your system.

Preview
The Preview check box is selected to display the Preview area in this dialog box. In the
Preview area you can preview the selected part, assembly, or drawing document before opening.

Advanced

The Advanced check box is selected to display the configurations available in the selected file.
The configurations available in the selected file are displayed in the Configurations area. You
will learn more about configurations in the later chapters.

View-Only

The View-Only check box is selected to open a SolidWorks document in the view only format.
When you open a view-only file, only the tools related to viewing the models are enabled. Rest of
the tools are not available. This is the reason you cannot do any modification in the view-only
document. You can only use the zoom, pan, or dynamically rotate tools. If you want to edit the
design, right-click in the drawing area and choose the Edit option from the shortcut menu to
edit the design.
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Lightweight
The Lightweight check box is selected to open the assembly document using the lightweight
parts. You will learn more about the lightweight parts in the later chapters.

TUTORIALS

Tutorial 1

In this tutorial you will draw the sketch of the model shown in Figure 3-49. This is the same
sketch that was drawn in Tutorial 1 of Chapter 1. In this tutorial you will draw the sketch using
the mirror line and then add the required relations and dimensions. The sketch is shown in
Figure 3-50. The solid model is given only for reference. (Expected time: 30 min)

¢ I -

; N

15

30 10

Figure 3-49 Solid Model for Tutorial 1 Figure 3-50 Sketch of the model
The steps that will be followed to complete this tutorial are listed below:

Start SolidWorks and then open a new part file.

Maximize the part file document and then switch to the sketching environment.

Create a mirror line using the Centerline and the Mirror tool.

Draw the sketch of the model on one side of the mirror line so that it is automatically drawn
on the other side, refer to Figure 3-51 through Figure 3-56.

e.  Add the required relations to the sketch, refer to Figures 3-57 and Figure 3-58.

f.  Add the required dimensions to the sketch and fully define the sketch, refer Figure 3-59.
g. Save the sketch and then close the file.

fo o

Starting SolidWorks and Opening a New Part Document

1. Start SolidWorks by choosing Start > Programs > SolidWorks 2003 > SolidWorks 2003
or by double-clicking the shortcut icon of SolidWorks available on the desktop of your
computer.

The Welcome to SolidWorks 2003 window is displayed and also the Tip of the Day dialog
box. As mentioned earlier, the tips that are displayed in the Tip of the Day dialog are very
useful in making the best use of SolidWorks.
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Close the Tip of the Day dialog box by choosing the Close button and then choose the New
Document option from the Welcome to SolidWorks window.

The New SolidWorks Document dialog box is displayed.

Select the Part option and then choose the OK button from the New SolidWorks Document
dialog box.

Anew SolidWorks part document is opened. But the part document window is not maximized
in the SolidWorks window.

Choose the Maximize button available on the upper right corner of the part document
window to maximize the document window.

Choose the Sketch button from the Sketch toolbar to invoke the sketching U?
environment.

Set the units for measuring linear dimensions to Millimeters and the units for angular
dimensions to Degree using the Document Properties - Detailing dialog box. If you
selected Millimeters as units while installing SolidWorks, then you can skip this point.

Drawing the Mirror Line

In this tutorial, you will draw the sketch of the given model with the help of a mirror line. As
mentioned earlier, the sketches that are symmetrical along any axis are recommended to be
drawn using the mirror line. The mirror line is drawn using the Centerline and Mirror
tools. When you draw an entity on one side of the mirror line, the same entity is drawn
automatically on the other side of the mirror line. The entity drawn on the other side is the
mirror image of the entity you draw. A symmetrical relation is applied to the entities on both
the sides of the mirror line. Therefore, if you modify an entity on one side of the mirror
line, the same modification is reflected in the mirrored entity and vice versa. First, you need
to create a mirror line.

The origin of the sketcher environment is placed in the center of the drawing area and you
have to create the sketch in the first quadrant. Therefore, it is recommended that you modify
the drawing area such that the area in the first quadrant in increased. This can be done
using the Pan tool.

Choose the Pan tool button from the View toolbar. The select cursor will be replaced 4_1_, |
by the pan cursor.

Press and hold the left mouse button down and drag the cursor toward the bottom left
corner of the screen.

You will notice that the origin also moves toward the bottom left corner of the screen. This
increase the drawing area in the first quadrant.

After dragging the origin close to the lower left corner, release the left mouse button.
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Choose the Centerline button from the Sketch Tools toolbar. :
The pan cursor is replaced by the line cursor.

Move the line cursor to a location whose coordinates are close to 45mm 70mm Omm. You do
not need to move the cursor to exactly this location. You can move it to a point close to this

location.

Specity the startpoint of the centerline and move the line cursor vertically downward. Specify
the endpoint of the centerline when the length of the line cursor shows a value close to 80.

As soon as you specity the endpoint of the center line, a rubber-band line is attached to the
line cursor. Double-click any where in the drawing area or right-click to display the shortcut
menu and choose the End chain option from the shortcut menu to end line creation.

Choose the Zoom to Fit button from the View toolbar to fit the sketch on the screen. @ |

Choose the Select button from the Sketch toolbar to toggle back to the selection [-\@
mode and select the center line.

Choose the Sketch Mirror button from the Sketch Tools toolbar to convert the ﬁl
center line into a mirror line and invoke the automatic mirror option. —_—

Drawing the Sketch

‘ c03-solidworks-2003.p65

You will draw the sketch on the right side of the mirror line and the same sketch will be
automatically drawn on the other side of the mirror line.

Choose the Line button from the Sketch Tools toolbar. % |
The arrow cursor is replaced by the line cursor.

Move the line cursor to a location where the coordinates are close to 45mm 10mm Omm.
The line cursor turns yellow in color and an orange bulb is displayed. This suggests that the
cursor snaps the mirror line.

Specify the startpoint of the line at this point and move the cursor horizontally toward the
right. Specify the endpoint of the line when the length of the line above the line cursor
shows a value close to 15. As soon as you press the left mouse button to specify the endpoint
of the line, a line of the same length is drawn automatically on the other side of the mirror
line. Figure 3-51 shows the mirror image created automatically on the other side of the
mirror line. A rubber-band line is attached to the cursor.

You will notice that the mirror image that is automatically created on the left of the mirror
line is merged with the line drawn on the right. Therefore, the entire line becomes a single
entity. As mentioned earlier, the mirror image of the line is merged with the line that you
draw only if one of the endpoints of the line you draw is coincident with the mirror line.
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4.

Move the cursor vertically upward. Specify the endpoint when the length of the line on the
line cursor displays a value close to 10. Figure 3-52 shows the sketch after drawing the
vertical lines.

Il\

Figure 3-51 After releasing the left mouse button Figure 3-52 After releasing the left mouse button

10.

11.

12.

A rubber-band line is attached to the cursor.

Move the line cursor horizontally toward the right. Specify the endpoint of the line when
the length of the line on the line cursor displays a value close to 10.

Move the line cursor vertically downward. Specify the endpoint when the length of the line
on the line cursor displays a value close to 10.

Move the line cursor horizontally toward the right. Specity the endpoint when the length of
the line on the line cursor displays a value close to 10.

Move the line cursor vertically upward. Specify the endpoint when the length of the line on
the line cursor displays a value close to 40.

Move the line cursor such that the line is drawn at an angle close to 135-degree, see Figure 3-53.
Specify the endpoint when the value of the length of the line is close to 14.14.

Move the line cursor horizontally toward the left. Specify the endpoint when the cursor
snaps to the mirror line and the line cursor turns yellow in color. A rubber-band line is
attached to the cursor. Double-click anywhere on the screen to end line creation. The sketch

after completing the outer loop is shown in Figure 3-54.

Next, you will draw the sketch of the inner cavity. To draw the sketch of the inner cavity, you
will start drawing the lower horizontal line.

Move the line cursor to a location whose coordinates are around 45mm 25mm Omm.

Specify the startpoint of the line at this point and move the cursor horizontally toward the
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13.

14.

15.
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Figure 3-53 Sketch after drawing the aligned line
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Figure 3-54 Skelch afier completing the outer profile of the sketch

right. Specify the endpoint when the length of the line above the line cursor shows a value
close to 15.

Move the line cursor vertically upwards. Specify the endpoint when the length of the line on
the line cursor displays a value close to 10.

Move the line cursor horizontally toward the left. Specify the endpoint when the length of
the line on the line cursor displays a value close to 10.

Move the line cursor vertically downwards. Specify the endpoint when the length of the line
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on the line cursor displays a value close to 5.

16. Move the line cursor horizontally toward the left. Specity the endpoint when the line cursor
snaps to the mirror line.

17. Double-click anywhere on the screen to end line creation. The sketch after completing the
inner cavity is shown in Figure 3-55.

Next, you will draw the circles using the Circle tool from the Sketch Tools toolbar.
18. Choose the Circle button from the Sketch Tools toolbar to invoke the circle tool. ()
When you invoke the circle tool the select cursor will be replaced by the circle cursor.

19. Move the circle cursor to the point where the inferencing line originating from the endpoints
of the right inclined line meet.

20. Specify the center of the circle at this point and move the circle cursor toward the left to
define the circle. Press the left mouse button when the radius of the circle above the circle
cursor shows a value close to 5.

The mirror image of the circle is automatically drawn on the other side of the mirror line.
The sketch after drawing the circle is shown in Figure 3-56.
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Figure 3-55 Skelch afier drawing the inner cavity — Figure 3-56 Sketch after drawing the circle

& Tip. Sometimes unwanted inferencing lines are displayed when you are drawing a
X sketch. You can remove the unwanted inferencing lines by choosing View > Redraw
from the menu bar. You can also redraw the screen by pressing CTRL+R key.

Adding the Required Relations

After drawing the sketch, you need to add the relations using the Add Relations
PropertyManager. The relations are applied to a sketch to constrain its degree of freedom,
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to reduce the number of dimensions in the sketch, and also to capture the design intent in
the sketch.

Choose the Select button from the Sketch toolbar to remove the circles created [:3
previously from the selection set.

Choose the Add Relation button from the Sketch Relations toolbar to invoke the
Add Relations PropertyManager. The confirmation corner is also displayed at the L |
upper right corner of the drawing window.

Select the centerpoint of the circle on the right and then select the lower endpoint of the
right inclined line. The name of the selected entities are displayed in the Selected Entities
area of the Add Relations PropertyManager.

The relations that can be applied to the two selected entities are displayed in the Add
Relations area of the Add Relations PropertyManager as shown in Figure 3-57. The
Horizontal option is highlighted, suggesting that the horizontal relation is the most
appropriate relation for the selected entities.

1@

F'l:nin

Existing Belations -~

o Under Defined

Add Relations -~

Figure 3-60 Add Relations PropertyManager
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., Note
%@d The name of the entities displayed in the Selected Entities area of the Add Relations
"~ PropertyManager may be different from those displayed on your screen.

4. Choose the Horizontal button from the Add Relations area to apply the Horizontal relation
to the selected entities.

5. Move the cursor to the drawing area and right-click to invoke the shortcut menu. Choose the
Clear Selections option to remove the selected entities from the selection set.

6. Select the centerpoint of the circle on the right and the upper endpoint of the right inclined
line.

The relations that can be applied to the selected entities are displayed and the Vertical
option is highlighted.

7. Choose the Vertical button from the Add Relation area of the Add Relations
PropertyManager. Right-click in the drawing area and choose the Clear Selection option.

8. Select the entities shown in Figure 3-58. Choose the Equal button from the Add Relations
area of the Add Relations PropertyManager.

=+

G o

I—l—l‘%nﬂk‘kg Entities to be selected

T for applying relation

N

-+

Entities to be selected
for applying relation

Figure 3-58 Entities to be selected to apply the equal relation

9. Choose the OK button from the Add Relations PropertyManager or choose the OK icon
from the confirmation corner to close the PropertyManager. Specify a point on the screen
to clear the selected entities.

Applying the Dimensions to the Sketch
Next, you will apply the dimensions to the sketch and fully define the sketch. As mentioned
earlier, the sketched entities are shown in blue, suggesting that the sketch is under defined.
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10.

11.

12.

13.

‘ c03-solidworks-2003.p65

It will be changed to black after applying the required dimensions to the sketch, suggesting
that the sketch is fully defined.

Choose Tools > Options from the menu bar to display the System Options - General
dialog box. Select the Input dimension value check box if cleared and choose OK from the
System Options - General dialog box. This check box is selected to invoke the modify
dialog box to enter a new dimension value and modify the sketch as you place the dimension.
Choose the Dimension button from the Sketch toolbar or right-click in the drawing o
area to display the shortcut menu. Choose the Dimension option to invoke the
dimension option.

The cursor is replaced by the dimension cursor.

Move the dimension cursor to the lower right horizontal line. The lower right horizontal
line is highlighted in red color.

Select the line. A linear dimension is attached to the cursor.

Move the cursor downwards and using the left mouse button, place the dimension below the
line, refer to Figure 3-59.

As you place the dimension, the Modify dialog box is displayed.

Enter the dimension value of 10 in this dialog box and press ENTER. The dimension is
placed and the length of line is also modified to 10.

Move the dimension cursor to the lower middle horizontal line. Select the line when the
line changes to red. A dimension is attached to the cursor.

Move the cursor downwards and place the dimension using the left mouse button. Enter a
value of 30 in the Modify edit box and press ENTER.

Move the cursor to the outer left vertical line and when the color of the line changes to red,
select the line. A dimension is attached to the cursor.

Move the cursor to the left and use the left mouse button to place the dimension. Enter a
value of 40 in the Modify dialog box and press ENTER.

Select the right inclined line. A dimension is attached to the cursor. Move the cursor vertically
upwards to apply the horizontal dimension to the selected line. Using the left mouse button
place the dimension at an appropriate place, see Figure 3-59.

Enter a value of 10 in the Modify dialog box and press ENTER.

Again, select the right aligned line. A dimension is attached to the cursor. Move the cursor
horizontally toward the right to apply the vertical dimension for the selected line. Using the
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left mouse button place the dimension at an appropriate place, see Figure 3-59.

18. Enter a value of 10 in the Modify dialog box and press ENTER.

19. Move the cursor to the left circle and when the circle is highlighted in red, select it. A
diameter dimension is attached to the cursor. Move the cursor outside the sketch.

20. Place the diameter dimension. Enter a value of 10 in the Modify dialog box and press
ENTER.

21. Select the lower horizontal line of the inner cavity. A linear dimension is attached to the
cursor. Select the lower horizontal line of the outer loop.
A vertical dimension between the lower horizontal line of the inner cavity and the lower
horizontal line of the outer sketch is attached to the cursor.

22. Move the cursor horizontally toward the right and place the dimension. Enter a value of 15
in the Modify dialog box and press ENTER.

23. Select the inner right vertical line of the cavity and place the dimension outside the sketch.
Enter a value of 5 in the Modify dialog box and press ENTER.

24. Select the lower horizontal line of the outer sketch and the origin using the left mouse
button.

25. Move the cursor horizontally toward the left and place the dimension. Enter a value of 10 in
the Modify dialog box.
Notice, that some of the entities are displayed in black. This suggests that these entities are
now fully defined. But you have to fully define the entire sketch. So you need to add some
more dimensions.

26. Select the outer left vertical line of the outer sketch and the origin.

27. Move the cursor vertically downward and place the dimension using the left mouse button.
Enter a value of 10 in the Modify dialog box.
Notice that all the entities are displayed in black. This suggests that the sketch is fully
defined. If the sketch is not fully defined then you have to add a dimension between the
outer right vertical line and the outer left vertical line. The value of the dimension should be
maintained 70. The fully defined sketch, after applying all the required relations and
dimensions, is shown in Figure 3-59.

Saving the Sketch

1.

Choose the Save button from the Standard toolbar to invoke the Save As dialog box. n
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Figure 3-59 Fully defined sketch after applying all the required relations and dimensions

2. Double-click the SolidWorks directory. Choose the Create New Folder button from i
the Save As dialog box. Enter the name of the folder as ¢03 and press ENTER.

3. Enter the name of the document as ¢c03-tut01.sldprt in the File name edit box and choose the
Save button.

The document will be saved in the \My Documents\Solid Works\cO3 directory.

4. Close the file by choosing File > Close from the menu bar.

Tutorial 2

In this tutorial you will draw the sketch of the model shown in Figure 3-60. You will draw the
sketch using the mirror line and then add the required relations and dimensions. The sketch is
shown in Figure 3-61. The solid model is given only for reference. ~ (Expected time: 30 min)

Figure 3-60 Solid Model Figure 3-61 Sketch of the solid model
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The steps that will be followed to complete this tutorial are listed below:

Start SolidWorks and then open a new part file.

Maximize the part file document and then switch to the sketching environment.
Create a mirror line.

Draw the sketch on one side of the mirror line, refer to Figure 3-62.

Trim the arcs and circles and add the fillets, refer to Figure 3-63 through Figure 3-65.
Add the required relations.

Add the dimensions and fully define the sketch, refer Figure 3-66.

w0 o

Opening a New File
1. Choose the New button from the Standard toolbar to invoke the New D|
SolidWorks Document dialog box.

2. Select the Part option and then choose the OK button from the New SolidWorks Document
dialog box.

A new SolidWorks part document is opened.

3. Choose the Sketch button from the Sketch toolbar to invoke the sketching L;?
environment.

Drawing the Mirror Line

Similar to the last tutorial, you will draw the sketch of the given model with the help of a mirror

line.

1. Choose the Centerline button from the Sketch Tools toolbar. i

1

2. Move the line cursor to a location whose coordinates are close to -102mm Omm Omm. You
do not need to move the cursor to exactly this location. You can move it to a point close to
this location.

3. Specify the startpoint of the centerline at this point and move the line cursor horizontally
toward the right. Specify the endpoint of the center line when the length of the line shows

avalue close to 204. Double-click anywhere in the drawing area to end line creation.

4. Choose the Zoom to Fit button from the View tollbar to fit the sketch on the screen. @

5. Invoke the Select tool and select the centerline. Choose the Sketch Mirror button [
from the Sketch Tools toolbar to create the mirror line and enable the automatic -le
mirror option.

Drawing the Sketch

You will draw the sketch on the upper side of the mirror line and the same sketch will be
automatically drawn on the other side of the mirror line.
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1. Choose the Centerpoint Arc button from the Sketch Tools toolbar. :.-;_j

10.
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The arrow cursor is replaced by the arc cursor.

Move the arc cursor close to the origin. Specify the centerpoint of the arc when the cursor
turns yellow in color. Move the cursor horizontally toward the right. The cursor snaps to the
mirror line. As you move the cursor, a reference circle is drawn. Specify the startpoint of the
arc when the radius of the arc on the arc cursor shows a value close to 82.

Move the arc cursor in the counterclockwise direction. Specify the endpoint of the arc when
the value of the angle above the arc cursor shows a value close to 30-degree. The mirror
image of the sketched entity is automatically created on the other side of the mirror line.

Move the arc cursor to the origin. Specify the centerpoint of the arc. Move it horizontally
toward the right. The cursor snaps to the mirror line and a reference circle is drawn. Specity
the startpoint of the arc when the radius of the arc on the arc cursor shows a value close to
56.

Move the arc cursor in the counterclockwise direction. Specify the endpoint of the arc when
the value of the angle above the arc cursor shows a value close to 30-degree. The mirror
image of the sketched entity is automatically created on the other side of the mirror line.

Choose the Tangent Arc button from the Sketch Tools toolbar. _.E, |

Move the cursor to the upper endpoint of the left arc and when cursor turns to yellow,
specify the first point of the tangent arc. Move the cursor close to the upper endpoint of the
right arc and when the cursor turns yellow, specify the second point of the tangent arc.

A rubber-band arc is attached to the cursor. Double-click anywhere in the drawing area to
end arc creation.

Choose the Circle button from the Sketch Tools toolbar. The arc cursor will be E:,
replaced by the circle cursor

Move the cursor to the centerpoint of the upper arc and when the cursor turns yellow,
specify the centerpoint of the circle. Move the cursor horizontally toward the right. Press
the left mouse button when the radius of the circle above the circle cursor shows a value close
to 7.5.

Move the cursor to the origin and when the cursor turns yellow, specify the centerpoint of
the circle. Move the cursor horizontally toward the right. Press the left mouse button when
the radius of the circle above the circle cursor shows a value close to 6.5.

The SolidWorks warning dialog box is displayed. This warning message will inform you
“Unable to create the symmetric element”. This message is displayed because the circle is
created on both sides of the mirror line. Therefore, a symmetric element is not created in
this case.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

Choose OK from the SolidWorks warning dialog box.

Move the cursor to the origin and when the cursor turns yellow in color, specify the centerpoint
of the circle. Move the cursor horizontally toward the right. Press the left mouse button
when the radius of the circle above the circle cursor displays a value close to 13. The
SolidWorks warning dialog box will be displayed.

Choose OK from the SolidWorks warning dialog box.
Choose the Line button from the Sketch Tools toolbar. . |

Move the line cursor to a location whose coordinates are close to 55mm 10mm Omm. The
cursor snaps to the left arc.

Specify the startpoint of the line at this point and move the cursor horizontally toward the
left. Specify the endpoint of the line when the line cursor snaps the outer circle. Double-click
anywhere in the drawing area to end line creation.

Move the cursor to a location whose coordinates are close to -10mm 10mm Omm.
Specify the startpoint of the line on this location and move the cursor horizontally toward
the left. Specify the endpoint when the length of the line above the line cursor shows a value

close to 42.

Move the line cursor such that the line is drawn at an angle close to 105°. Specify the
endpoint when the length of line is close to 15.

Note
% You may need to scroll down the Line PropertyManager to view the angle. Move the cursor to

20.

21.

22.

23.

the scroll bay; press and hold down the lefi mouse button, and drag the cursor vertically downwards
to scroll down the Line PropertyManager.

Move the line cursor horizontally toward the left. Specify the endpoint when the length of
the line above the line cursor shows a value close to 34.

Move the line cursor vertically downwards. Specify the endpoint when the length of the line
above the line cursor shows a value close to 10.

Move the line cursor such that the line is drawn at an angle close to 346-degree. Specity the
endpoint when the length of the line is around 27.

Move the line cursor vertically downwards. Specify the endpoint when the line cursor snaps
the mirror line. Double-click anywhere in the drawing area to end line creation.

The sketch after drawing the required arcs, circles, and lines is shown in Figure 3-62.
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Figure 3-62 Complete sketch

Trimming the unwanted entities

After creating the sketch, you need to trim some of the unwanted sketched entities using the
Sketch Trim tool.

1. Choose the Sketch Trim button from the Sketch Tools toolbar to invoke the trim g:f_
tool.

The line cursor is replaced by the trim cursor.

2. Select the entities to be trimmed as shown in Figure 3-63. The entities are dynamically
trimmed.

Entities to N
be trimmed Entities to

be trimmed

Entities to
be trimmed

Figure 3-63 Entities to be trimmed

Adding the Fillets to the Sketch

Next, you need to add fillets to the sketch. The fillets are generally applied to avoid the
stress concentration at sharp corners.

1. Choose the Sketch Fillet button from the Sketch Tools toolbar. = |

The Sketch Fillet PropertyManager is displayed and the trim cursor is replaced by the
select cursor.

c03-solidworks-2003.p65 49 5/12/2003, 9:45 AM



3-50 SolidWorks for Designers

2. Set the radius spinner to 5.
3. Using the left mouse button, select the entities shown in Figure 3-64 to apply the fillet.
4. Choose the OK button from the Sketch Fillet PropertyManager to exit the Fillet tool.

The sketch after applying the fillets to the sketch is shown in Figure 3-65.

Entities to be selected
far applying fillet

Entities to be selected
for applying fillet

applying fillet

Entities to be selected
for applying fillet

Figure 3-64 Entities to be selected to apply fillet

Figure 3-65 Sketch after creating the fillets
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Adding the Relations to the Sketch

Next, you need to add the required relations to the sketch.

Choose the Add Relations button from the Sketch Relations toolbar to invoke the L |
Add Relations PropertyManager.

Select the lower left arc and the lower tangent arc. The Tangent button is highlighted bold
in the Add Relations rollout of the Add Relations PropertyManager. This suggests that
the Tangent relation is the most appropriate relation for the selected entities.

Choose the Tangent button from the Add Relations PropertyManager.
Right-click in the drawing area and choose the Clear Selections option from the shortcut
menu to clear the selections from the selection set. Select the right arc and the lower tangent

arc. The Tangent button is highlighted.

Choose the Tangent button from the Add Relations PropertyManager. Clear the current
selections from the selection set.

Select the right horizontal line and the left horizontal line that are coincident with the
trimmed circle. Choose the Collinear button from the Add Relations PropertyManager.

Choose the OK button from the Add Relations PropertyManager or choose the OK icon
from the confirmation corner.

Adding the Dimensions to the Sketch

‘ c03-solidworks-2003.p65

Next, you will apply the dimensions to the sketch and fully defined it.

Choose the Dimension button from the Sketch toolbar to invoke the 0
dimension tool. The arrow cursor is replaced by the dimension cursor.

Select the right arc. A radius dimension is attached to the cursor. Move the cursor away from
the sketch toward the right and place the dimension.

Enter a value of 82 in the Modify dialog box and press ENTER.

Select the left upper arc. A radius dimension is attached to the cursor. Move the cursor away
from the sketch toward the right and place the dimension.

Enter a value of 56 in the Modify dialog box and press ENTER.
Select the Origin and the centerpoint of the upper circle. A dimension is attached to the
cursor. Next, select the right endpoint of the mirror line. An angular dimension is attached

to the cursor. Place the angular dimension outside the sketch.

Enter a value of 30 in the Modify dialog box and press ENTER.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

Select the upper right circle and a diameter dimension is attached to the cursor. Place the
dimension outside the sketch.

Enter a value of 15 in the Modify dialog box and press ENTER.

Select the upper right horizontal line that coincides the trimmed circle and the lower right
horizontal line that coincides the trimmed circle. A linear dimension is attached to the
cursor. Move the cursor vertically downwards and using the left mouse button place the
dimension.

Enter a value of 20 in the Modify dialog box.

Select the smaller circle at the center. A diameter dimension is attached to the cursor. Move
the cursor upwards and place the dimension outside the sketch.

Enter a value of 13 in the Modify dialog box.

Select the outer trimmed circle and place the radius dimension outside the sketch.

Enter a value of 19 in the Modify dialog box.

Select the upper left inclined line. A dimension is attached to the cursor. Now, select the
upper left horizontal line. An angular dimension is attached to the cursor. Place the dimension
above the horizontal line.

Enter a value of 75 in the Modify dialog box.

Select the origin and the lower endpoint of the lower left inclined line. Move the cursor
vertically downwards and place the dimension.

Enter a value of 49 in the Modify dialog box.

Select the origin and the middle left vertical line. Move the cursor vertically downwards and
place the dimension below the last dimension.

Enter a value of 61 in the Modify dialog box.

Select the origin and select the lower endpoint of the outer left vertical line. Move the cursor
vertically downwards and place the dimension below the last dimension.

Enter a value of 90 in the Modify dialog box.
Select the upper left inclined line, and the lower left inclined line, refer to Figure 3-66. An
angular dimension is attached to the cursor. Move the cursor horizontally toward the left

and place the dimension.

Enter a value of 28 in the Modify dialog box.
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206.

27.

28.

29.

Select the upper left horizontal line and the lower left horizontal line. A linear dimension is
attached to the cursor. Move the cursor horizontally toward the left and place the dimension.

Enter a value of 50 in the Modify dialog box.

Select the lower endpoint of the upper left vertical line and the upper endpoint of the lower
left vertical line. A linear dimension is attached to the cursor. Move the cursor horizontally
toward the left and using the left mouse button place the dimension.

Enter a value of 30 in the Modify dialog box.

All the entities are displayed in black, suggesting that the sketch is fully defined. The fully
defined sketch is shown in Figure 3-66.

A0
30
E

Figure 3-66 Sketch after applying all relations and dimensions

Saving the Sketch

3.

Next, you need to save the document in the \My Documents\SolidWorks\c03 directory.
Choose the Save button from the Standard toolbar to invoke the Save As dialog box. E |

Enter the name of the document as c03-tut02.sldprt in the File name edit box and choose the
Save button.

The document will be saved.

Close the file by choosing File > Close from the menu bar.

Tutorial 3

In this tutorial you will draw the sketch of a revolved model shown in Figure 3-67. The sketch is
shown in Figure 3-68. The solid model is given only for your reference.
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(Expected time: 30 min)
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Figure 3-67 Solid model of the piston Figure 3-68 The sketch of the base feature

The steps that will be followed to complete this tutorial are listed below:

o®

o an

Open a new part file and then switch to the sketching environment.

Create a center line that will act as the axis of revolution when you will create the base feature
using this sketch.

Create the sketch using the various sketching tools.

Use the offset tool to offset the required lines, refer to Figure 3-69.

Draw the arcs and trim the unwanted entities, refer Figure 3-70.

Add the required relations.

Add the required dimensions and fully define the sketch, refer Figure 3-71.

Opening a New Part File

1.

Choose the New button from the Standard toolbar and open a new part file using M
the New SolidWorks Document dialog box.

Choose the Sketch button from the Sketch toolbar to switch to the sketching U-’?
environment for drawing the sketch.

Creating a Center line

You need to create a center line around which the sketch of the base feature will be revolved.

1. Choose the Centerline button from the Sketch Tools toolbar. i
1
2. Move the cursor to the origin and specify the startpoint when the line cursor turns yellow.
Move the cursor vertically upwards. Specify the endpoint when the length of the line cursor
shows a value close to 120.
Drawing the Sketch
Next, you will draw the sketch of the piston.
1. Right-click in the drawing area and choose the Line option from the shortcut menu. Move
the cursor to a location whose coordinates are close to 58mm Omm Omm.
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Draw a vertical line of dimension close to 100. Choose the End chain option from the
shortcut menu.

3. Move the cursor to the lower endpoint of the line created earlier. Specify the startpoint of
the line when the cursor turns yellow. Move the cursor horizontally toward the left and
create a horizontal line of dimension close to 8.

4. Move the line cursor vertically upwards and create a vertical line of dimension close to 30.

5. Move the cursor horizontally toward the left and create a horizontal line of dimension close to 7.

6. Move the line cursor vertically upwards and create a vertical line of dimension close to 70.

7. Right-click and choose the 3 Point Arc option from the shortcut menu. Move the cursor
near the upper endpoint of the right vertical line.

8. Specify the first point of the arc when the cursor changes to yellow color. Move the cursor
horizontally toward the left. The reference arc is attached to the cursor. Specify the second
point of the arc when the value of the length is close to 116.

9. Move the cursor vertically upwards. Specity the third point of the arc when the value of the
radius is close to 170.

10. Right-click and choose the Line option from the shortcut menu. Move the line cursor to
a location whose coordinates are close to 58mm 90mm Omm. Specify the startpoint of the
line at this location and move the cursor horizontally toward the left to create a line of
dimension close to 5. Double-click anywhere in the drawing area.

11. Choose the Zoom To Fit button from the View toolbar to fit the sketch to the drawing area.

Offsetting the lines
Using the Offset Entities tool you will offset the entities created earlier.

1. Select the line created previously using the select tool.

2. Choose the Offset Entities button from the Sketch Tools toolbar to invoke the
Offset Entities PropertyManager. The confirmation corner is also displayed at the = |
upper right corner of the drawing area. 2

3. Choose the Keep Visible button from the Offset Entities PropertyManager to pin the
PropertyManager.

4. Set the value of Offset Distance spinner to 5. Now, select the Reverse check box because
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you need to offset the entity in the reverse direction.

As soon as you select the Reserve check box you will observe that the preview of the entity
to be offset is modified in the drawing area.
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8.

Choose the OK button from the Offset Entities PropertyManager. You will notice that an
entity is created at an offset distance of 5 from the original entity.

You will notice that a dimension is also attached to the newly created entity and the original
entity with a value of 5. This dimension is the offset distance between the two entities.

Select the newly created entity. Move the cursor vertically downwards. The preview of the
entity and the direction of offset creation is also displayed. Press the left mouse button to

offset the selected line.

Repeat this procedure of offsetting the entities unless you get the eight entities including
the original entity.

Set the value of Offset Distance spinner to 7 and clear the Select chain check box. Select
the upper arc. The preview of the offset arc is shown in the background.

Choose the OK button twice on the Offset Entities PropertyManager.

Completing the Remaining Sketch

Next, you will complete the remaining sketch using the line tool.

Right-click and choose the Line option from the shortcut menu. Move the line cursor to the
left endpoint of the upper smaller right horizontal line. When the cursor turns yellow in
color, create a vertical line that snaps the endpoint of the last offseted line. Double-click to
end line creation.

Move the cursor to the intersection point of the upper arc and the centerline. When the
cursor snaps the intersection, create a vertical line that snaps the intersection point of the
lower arc and the centerline.

The sketch after creating the entities using the various sketch tools and the offset tool is
shown in Figure 3-69.

Trimming the Unwanted Entities

1.

2.

Next, you will trim the unwanted entities using the trim tool.
Choose the Trim button from the Sketch Tools toolbar. o |

Using the left mouse button trim the unwanted entities. The sketch after trimming the
unwanted entities is shown in Figure 3-70.

Adding the Required Relations

1.

Now, you will add the required relations to the sketched entities.

Right-click and choose the Select option from the shortcut menu. Press and hold down the
CTRL key from the keyboard and select one of the endpoints of the lower horizontal line
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Figure 3-69 Sketch after creating various entities Figure 3-70 Sketch after trimming the unwanted
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entities

and then select the origin. Release the CTRL key after selection. Right-click and choose the
Make Horizontal option from the shortcut menu to add the horizontal relation to the
selected entities. Click anywhere in the drawing area to clear the selection set.

Press and hold down the CTRL key and select the small horizontal lines in the right of the
sketch. Release the CTRL key after making the selection and right-click to display the
shortcut menu. Move the cursor to two down arrows displayed at the end of the shortcut
menu. Keep the cursor on this location for a couple of seconds to expand the shortcut
menu. Choose the Make Equal option from the shortcut menu to apply the equal relation.

Similarly, apply the Equal relation to all the small vertical lines.

The SolidWorks warning message window will be displayed. This warns you that the solution
cannot be determined for the sketch. You will notice that some the entities of the sketch turn
red. This indicates that the sketch is over defined.

Choose OK from this dialog box.

Another SolidWorks dialog box is displayed. This warns you that applying this relation will
result in over defining the sketch.

Choose OK from this dialog box.

As discussed earlier, the overdefined sketch is not used to create any feature; therefore, you
have to delete the conflicting relations. The sketch is over defined after applying the previous
relation. Therefore, if you delete the last applied relation using the Undo button from the
Standard toolbar then the sketch will not be over defined.

Choose the Undo button from the Standard toolbar. Click anywhere in the drawing

. . K
area to clear the selections from the selection set.

57 5/12/2003, 9:45 AM



3-58 SolidWorks for Designers

As evident from the color of the entities, which is green, you still have to add some more
relations or dimensions to fully define the sketch. The fully defined sketch is displayed in
black color.

7. Zoom in using the Zoom In/Out tool and apply the coincident relation between the
centerpoint of the upper arc and the centerline.

Adding the Dimensions to the Sketch

After creating, editing, and applying the relations to the sketch, you will add the required
dimensions to the sketch to fully define the sketch.

1. Select the dimension with a value of 7 that is placed between the upper arcs and press the
DELETE key from the keyboard.

The SolidWorks dialog box is displayed. This warns you that if you delete the offset dimension,
the offset relation will also be deleted from the sketch.

2. Choose the Yes button from this dialog box.

You have to delete this dimension because during the design and manufacturing practices
the dimension between the tangents should be avoided.

3. Right-click and choose the Dimension option from the shortcut menu to invoke the
Dimension tool.

4. Select the outer upper right vertical line. A dimension is attached to the cursor. Now, select
the centerline and move the cursor to the other side of the centerline. You will notice that
the diameter dimension is displayed along the cursor.

5. Using the left mouse button place the dimension above the sketch and enter a value of 116
in the Modify edit box and press ENTER.

6. Now, select the inner left vertical line and then select the centerline. Move the cursor to the
other side of the centerline and place the dimension using the left mouse button below the
sketch.

7. Enter avalue of 86 in the Modify edit box and press ENTER.

Add the remaining dimensions to fully defined the sketch. Refer to Figure 3-71. Using the
left mouse button select one of the dimensions that are created after offsetting the entities
and drag the cursor toward the right and using the left mouse button place the dimension at
an appropriate place. Arrange all the dimensions using the above method. The fully defined
sketch is shown in Figure 3-71.

Saving the Sketch

Since the document has not been saved once until now, therefore, when you choose the Save
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Figure 3-71 Fully defined sketch after applying all the relations and dimensions

button from the Standard toolbar, the Save As dialog box will be displayed. You can enter
the name of the document in this dialog box.

Choose the Save button from the Standard toolbar and save the model with the H
name given below:

\My Documents\SolidWorks\cO3\cO3-tut02.SLDPRT.

Choose File > Close from the menu bar to close the file.

SELF-EVALUATION TEST

Answer the following questions and then compare your answers with the answers given at
the end of this chapter.

1.

2.
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The Trim option is also used to extend the sketched entities. (1/F)
In the sketching environment you can apply fillets to two parallel lines. (T/F)
You can apply a fillet to two nonintersecting entities. (I/F)

You cannot offset a single entity; you have to select a chain of entities to create an entity
using the offset tool. ('1/F)

You can do modifications in the view-only file. (1/F)
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6. The PropertyManager is displayed using the Add Relation button from the
Sketch Relations toolbar.

7. The dimension is used to dimension a line that is at an angle with respect to
the X axis or the Y axis.

8. The defined sketch is a sketch in which all the entities of the sketch and their
positions are described by the relations or dimensions, or both.

9. The dimensions or relations are not able to determine the position of one or
more sketched entities.

10. The option is displayed in the Defined In column when the entity is defined

as placed in the same sketch.

REVIEW QUESTIONS

Answer the following questions:

1. You can invoke the Sketch Relations PropertyManager using the Display/Delete Relations
button from toolbar.

2. The Document Properties - Grid/Snap dialog box is displayed using the
button from the Sketch toolbar.

3. The option is used to display all the relations of the sketch in the Sketch
Relations PropertyManager.

4. The sketch geometry is constrained by too many dimensions and/or relations.
Therefore, you have to delete the extra and conflicting relations or dimensions.

5. The relation forces two selected lines, arcs, points, or ellipses to remain
equidistant from a centerline.

6. InSolidWorks, by default, the dimensioning between two arcs, two circle, or between an arc
and a circle is done from
(a) Centerpoint to centerpoint (b) Centerpoint to tangent
(c) Tangent to tangent (d) None

7. Which relation forces the selected arc to share the same centerpoint with another arc or a
point?
(a) Concentric (b) Coradial
(c) Merge points (d) Equal
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8.  Which PropertyManager is displayed when you choose the Fillet button from the Sketch
Tools toolbar?

(a) Sketch Fillet (b) Fillet
(c) Surface Fillet (d) Sketching Fillet

9. Which dialog box is displayed when you modify a dimension?

(a) Modify Dimensional Value (b) Insert a value
(c) Modify (d) None

10. When you add an extra dimension to a sketch or add an extra relation that over defines the
sketch, then which dialog box is displayed?

(a) Over defining (b) Delete relation
(c) Make Dimension Driven? (c) Add Geometric Relations

EXERCISES

Exercise 1

Create the sketch of the model shown in Figure 3-72. Create the sketch and apply the required
relations and dimensions and fully define the sketch. The sketch is shown in Figure 3-73. The
solid model is given only for reference. (Expected time: 30 min)
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Figure 3-72 Solid model for Exercise 1 Figure 3-73 Sketch for Exercise 1

Exercise 2

Create the sketch of the model shown in Figure 3-74. Create the sketch and apply the required
relations and dimensions and fully define the sketch. The sketch is shown in Figure 3-75. The
solid model is given only for reference. (Expected time: 30 min)
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Figure 3-74 Solid model for Exercise 2 Figure 3-75 Sketch for Exercise 2

Exercise 3

Create the sketch of the model shown in Figure 3-76. Create the sketch and apply the required
relations and dimensions and fully define the sketch. The sketch is shown in Figure 3-77. The
solid model is given only for reference. (Expected time: 30 min)
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Figure 3-76 Solid model for Exercise 3 Figure 3-77 Sketch for Exercise 3

Answers to Self-Evaluation Test
1.T, 2. F, 3. T, 4. F, 5. T, 6. Add Relations, 7. aligned, 8. fully defined, 9. Dangling, 10. All in
this sketch
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